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・ 」「Help

＊ ：目次Iindex

WellcomeTo SideSaddles, Any Size Picture・

・ ： ヘルプSideSaddles Help

・ ： 情報SideSadlle- Info

・ ： と 画像Rx and Tx Pictures.htm RX TX

・ ： 画像の選択Selecting Pictures for Tx TX

・ ：セットアップSetting Up SideSaddles

・ ：テキストチャットヘルプText Chat Help

・ ：テキストヘルプText Help

・ ：テキスト書き込みadding text

・ ：テキストチャットSideSaddle Text Chat

・ ： 「 ：テキストエフェクト」Text Effects TE」

・ ：オンラインフォーラムSideSaddle Onlain forum

・ ：オンラインヘルプXP Freewall Online Help

・ ようこそ「 」へWellcome To SideSaddles ： SideSaddle

・ 」は、作業の途中のものです。「Sidesaddle

この仕事は、ネット上で、どんなサイズや縦横比の画像でも送信できることという

単純な哲学から始めました。

このプログラムは、プロのコードライターでは構築されていません。
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、 「 」 「 （ ）しかし 私自身のような アマチュアラジオオペレーター と他の 電子熱中 道楽

者」によって作られました。

このプログラムのコストは 「ゼロドルとゼロセント」です。、

、 、 、 。そして これは 世界中のファンによって作られたのですから この価格で適切です

ご覧いただけるすべての画像は、ほとんどがニュージーランドのジョーによって設計

されました。

私はプログラムを作動させる内部のコーディングの多くを担当しました。

最初の不十分なテストから、問題の修正を手助けしてくれた熱心な「ベーターテス

ター」がいます。

ウエスト・ヴァージニア、 の 。Parkersburg KO8OK

オハイオの 。WW8MM

ウエストバージニアの 。KC8VSS

カリフォルニアの 。N6QDY

フロリダのフランキーに深謝します。

・ヘルプファイルプログラムは、イギリスのカンタベリーからデイビッド、

が作ってくれました。2E1EHM

このボランテイアのみなさんが、このプログラムを作動させることのために、

時間と努力を投入しました。

提案は正しく評価されます。もしヘルプが必要なときは 「ヘルプフォーラム」を、

チエックしてください。

、 、 。すべての新しいプログラムのように ヘルプファイルは 若干遅れる傾向があります

この仕事の進行につれて、プログラムのこの領域が年ごとに改善されていくように

望んでいます。

幸運を祈りつつ、健康を願い、 ７３

Dan, WB5HKK

ヘルプ＊ SideSaddle

この画像のボタンの上をマウスで走らせると、ヘルプが「テキストメッセージ」

で表示されます （ マウス」を当てると「ヘルプ」がポップアップします）。「

ボタンをクリックすると、他の「ヘルプページ」に移ります。

・ここをクリックして「ダウンロード」します。
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で画像を受信するには、 ポートの と を開く・SideSaddle TCP 27224 27225

。必要があります

（ ： 」の が完成しないと、訳注 ファイアーウオールの設定「Windws XP

（ ）になります。送信専用 ？

「 」の「 」で 「 」のローカルエリア接続のプロパテイ 詳細設定 サービス設定、

「 」を追加してください ）ポートの設定 。

＊ ：情報SideSaddle Info－

Rx and Tx Pictures.htm・

・ ： または を見るにはどちらかを選びます。TX RX TX RX

両方とも見るときは「 ：サムネイル」を選びます。Thumbnails

・ ： から に自動的に切り換わります。Auto TX RX

・ ： 画像を最大画面で見るときに、これを選びます。Big Picture RX

マウスの左側ボタンをクリックすると最大画面になり、右側ボタン

でもとに戻します。

・ ： ・ 」画像を「クリックボード」にコピーします。Copy 「 」「TX RX

「 ：テキストエッフェクト（画像処理 」に運びます。TE ）

・ ：クリップボードの画像を貼り付けます。Paste

「 」でテキスト処理した画像を「ＴＸ」画面に貼り付けます。TE

・ ： 」画像を「 」画面に取り込みます。Forward RX 「RX TX

送られた画像を、他の誰かに送りたいときには、送りたい局をクリ

ックして 「 」ボタンを押します。、 Forward RX

・ ：受信画像をセーブ（保存）します。Save

「 」 、 「 」Auto save onを にしていないときに この選択で 受信画像

を「セーブ」できます。

・ ：あなたの「 ホルダー」にあるサムネイルを見る「プログラHistory History

ム」を起動します 「 」ボタンを右クリックすると 「エク。 、History

スプローラー」で「 」ホルダーが開きます。History

・ ： このボタンで 「 」ホルダーや他のすべてのホルダーで選Delete 、 History

択して「ハイライト」にしたファイルを削除します。
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「 」にチエックをつけているときに、受信した「 」をAutosave Last picture

保存したくないときは 「 」ボタンを押します。、 delete

・ ：送信者の と最新の 画像の アドレスとコールサインを表示RX Info IP RX IP

します。

「 」 、 「 」最新の受信 を一度クリックすると ウインドウから Text Effects

「 」にコールサインをコピーできます。text box

右クリックして「 」を選択して 「 」を押します。paste apply、

・ ：ファイル 情報。File RX TX Info RX TX

ファイル情報。名前。サイズ。フォーマットが分かります。

・ ：自動転送 Bot「 」Auto Replay Bot

自動的に画像を転送することを可能にします。

このためには、最初に、Ｃドライブでプログラムの「 」ホルダーSideSaddle

を探します。 その中にある「 」がこれです。Auto Send

このホルダーに自動転送する画像ファイルを取り込みます。

これには、送る順に「１ 」の順版を付けてリネームします。---100

そして「 」にチエックを付けます。Auto Replay Bot

IP・ ： 自動転送「 」Auto Reply IP

このチエックを削除すると あなたが選択した唯一の局とだけコンタクト 接、 （

続）出来ます。

「 」 「 」 「 」メインウインドウ には あなたのメッセージ として Tx Rx BusyThankyou

が自動的に表示されます。

このボックスにチエックが戻されたときは 「メッセージ」はもとに戻り、、

リストにある誰とでも画像の送信が出来るようになります。

・ ： 」へオートセーブ。「 」「Auto Save to History History

受信した画像を 「 （履歴）フォルダー」に自動的にセーブ、 History

する時は、ボックスに「チエック」します。

・ ：このボックスにチエックしてあるときは、受信された画像が「 」Rx PopUp

「 ：ビッグ画像」ウインドウに自動的に表示されます。Big Picture
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＊ ： 送信画像の選択と送信Selecting Pictures for Tx

：メインウインドウ・Main Window

送信する画像を選択した後で、あなたが送信したい人をクリックしてから、

「 」ボタンをクリックしてください。Send

メインスクリーンで、マウスの左側ボタンをクリックすると、大きな画面が作られ

ます。そこで、他人からの「テキスト」を読むことができます。

そして、小さな画面にするためマウスを解放します。

ウインドウに画像があるときは、画像を送信したいコールサインをマウスでTX

左クリックしてから、右クリックで送信します。

・ ：デイスコネクトDisconnect

サーバーからログオフして、接続を切ります。

・ ：リセットReset

とＲＸウインドウの両方をクリアーし、サーバーもリセットします。TX

・ ： プログラムを 終了します。Exit

・ ： 画像を送信する時にここをクリックします。Send

・ ： 送信したい画像があるドライブとフォルダーを選択します。Drive

・ ： 適切な画像。送信したい画像のフォーマットは、Valid Pics

か のどちらかだけを選んでください。jpg bmp

・ ： デイスコネクト （サーバーからログオフして、接続を切ります）Disconnect

・ ： ここにはコールサインと彼らのＩＰアドレスが表示されます。Send To

ファイルが「送られた」か 「失敗した」時は、下の「ボックス」に、

表示がされます。

・ ： 入出力表示In Out Display

画像が「来たとき」や「送られた」時に表示されます。

＊「 」Ｍｅｎｕ：メニュー

１「 」. File：ファイル

ここで「 」プログラムを終了し、閉じます。Side Saddle

２「 」. Setup ：セットアップ

ここで「 」の表示色の選択が出来ます。Side Saddle
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＊メニューの「 」で「 ：ユーザーカラー」を開いて、Set Up User Color

「 （ ） 」 「 」 。Main Color メインカラー ：画面のメインカラー を 色見本 で選択します

「 （リストボックスカラー ：コンタクト局リストボックスの色をBox List Color ）」

選択します。

・ （テキスト ：コンタクト中の局の情報表示の色」「 ）Text

・ （バックカラー ：背景色」「 ）Back Color

・ ：送信・受信ウインドウSend and Recieved Windows

「 」ウインドウは、あなたが送信する画像をロードし、ＴＸ

「 」ウインドウは、あなたが受信した画像が表示される場所です。ＲＸ

「ＴＸ」ウインドウに画像があるとき 「 」ボタンをクリックすると、画像が拡大、 TX

されます。受信された画像も同じようにできます。

それぞれから、二つのウインドウに戻すには 「 ：サムネイル」ボタンを、 Thumbnails

クリックするか 「マウスフォイール」を前方に動かします。、

・ ：コールサイン」「Callsign

ここには、あなたの有効な「ハムまたはＳＷＬのコールサイン」を登録します。

もし、 の時には、 コールに名前か任意のナンバーのどちらかを付けるこSWL SWL

SWL9432, SWLbillとが好ましいです。例えば、

・ ：ワン（ ）ツー ワン）ＩＰ「1 To 1 IP One

ここには、あなたが選択した「送信する局」のＩＰが表示されます。

「１ １ 」ボックスを すると 「 」に変わり 「 」to IP 左クリック 赤色、 、 AutoReply IP

ボックスのチエックが削除されます。

すると 「 」ボックスのチエックが置き換えられます。右クリック 、 AutoReply IP

「１ 」が であるとき、誰からでも画像を受け取ることが出来ます。To 1 IP 緑色

・ 」「On- line, Off-line

これで、あなたが「サーバー」に接続しているかどうかが分かります。

-・ ：コメント」「Comment

ここには、あなたの名前や などどんなコメントでも記入できます。QTH

・ ：サーバー」「Server

もし 「メインサーバー」がダウンしているときは、代わりの「サーバー」を、

選択してください。

・ ：サーバーディスプレイ」「Server Display

ここには 「 」で使える異なる「サーバー」が表示されます。、 SideSaddle

これで、あなたが選択した「サーバー」と接続できます。

それから 「 ：リフレッシュ」ボタンで切り替えます。、 refresh
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それで、誰が「オンライン」しているかを見るために「サーバー」リストを

）・ ：コネクト （接続「 」Connect

これをクリックすると、あなたが選択したサーバーにコネクトします。

このボタンは、誰がオンラインしているかを見るために 「サーバーリスト」を、

リフレッシュすることが出来るように「 （更新 」ボタンに変わります。refresh ）

３.「 ：テキストチャット」Text Chat

・メニューバーの「 」を押すと 「テキストチャット」ボックスが開きます。Text Chat 、

次の手順で実行します。

・メニューの「 」を押して開きます。Text Chat

・ 」を押します。「Star t

・送信文の「テキスト」を下の「枠」に、記入します。

・ 局リスト」から「局」を選択して 「 」を押します。「 、 Send

上の「枠」に、送信文・受信文が表示されます。

・ チャット」をします。「

・ ：終了します。「 」Quit

・ ： テキスト枠」の内容をすべてを消去します。「 」「Clear All

・ ：送信・受信した「メッセージ」が表示されます。「 」受信ウインドウ

・ ：送信したいテキスト（最大 文字）をここに記入「 」送信テキストウインドウ 154

します。

・ ： ユーザーリスト」から希望する局を「クリック」して、「 」「Text send ボックス

「 」をクリックします。Send

・ ： 背景色を（最初の）黒色から変更するには 「カラーパレット」「 」 、背景色の変更

を呼び込むために「黒色」のどこかの場所を右クリックします。

「 ：テキストを右クリックして「テキスト」カラーを変更するテキスト色の変更」

「パレット」を取り出します。

・ ：テキストウインドウが一杯になったら 「 」ボタンを押すこ「 」 、Clear All Clear All

とを忘れないようにしてください。

・ 」 ： テキストチャット機能を終わります。「Quit
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・ ：「 」RX Text ボックス

２つのボックスには、テキストを送信する「 」と「 」がIP アドレス コールサイン

表示されます。

「 」が「チエック」されていないと 「 とコールサイン」は変わりAuto Accept 、 IP

ません。

・ ： ビジーメッセージ」を有効にします。「 」「Enable Busy Message

このボックスに「チエック」して 「 」とか、あなたが選んだ何かの短、 Sor ry Busy

いメッセージを下のボックスに書き込んでおきます。

あなたにテキストを送っている皆が、そのメッセージを受け取ります。

そして、あなたの「チャットボックス」は開きません。

・ ：自動受信「 」Auto Accept

これがチエックされていてもいなくても、誰からのテキストが受信できます。

チエックされていないときは、Ａ局があなたにテキストを送り、それからＢ局が

あなたにテキストを送ってくると、テキストチャットを続けるために 「コールサ、

インリスト」からＡ局を選択できません。

・ ：テキスト開始。「 」Star t Text

テキストを送るためには、どんなテキストでもタイプする前に 「 」ボタンを、 star t

・ ：このボタンで送信します。「 」Send

： テキストヘルプ＊ Text help

・ （トップスクリーン中央の下部）「 」Valid Pictures

送信したい画像を見つけて 「ファイル名」をダブルクリックすると、、

「 」がポップアップします。Text Editor Windows

画像に選択したテキストを書き込めます。

「 」ウインドウにある「ボタンの選択」は次の通りです：Edit Pix

・ ：フォント変更「 」Change Font

「 」 、 「 」このボタンで フォント選択画面 を開いて フォントの 色・スタイル・サイズ

を変更して選択します。
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・ ：フォントの背景色「 」Font BackGround

このボタンで「カラーパレット」を開いて、フォントの背景色を選択します。

・背景色を削除して、透過型テキストに戻すには 「 」ボタンを、 Font BackGround

右クリックします。

・ ：テキスト固定「 」Set Text

ボックスにテキストをタイプしたら、テキストを取り込むために画像上を左クリッ

クします。

、 。場所や見栄えが良くないときに もう一度やり直すには右クリックして削除します

場所や見栄えが万事好みになったら、画像上に保存するために「 」をクリSet Text

ックします。

他のテキストや他の行に追加する時は、同じ手順を繰り返します。

TX -・ ： へロード「 」Load TX

テキストの書き込みがすんだら、このボタンをクリックして、送信するために

「 」ウインドウに画像をロード（転送）します。TX

・ ：ウインドウに画像の表示を「フィット： 定着 」させる。「 」 （ ）Fit to Window View

このボックスに「チエック」すると、大きい画像がこのウインドウの中に表示され

ます。

サムネイルを見るためにこのボックスに「チエック」しているときは、画像の品質

が低下されることに注意してください。

＊ ：「SideSaddle adding text」
この画像の「ヘルプ」を見るためには 「 」ボタンの上にマウス、「Font BackGround

を置くとテキストメッセージが表示されます。

ボタンをクリックしたら、他のページが開きます。
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＊「 」SideSaddle TextChat
は、画像の交換と同時に「テキストチャット：文字会話」ができるSideSaddle

最初のプログラムです。

これを働かせるには 「 」を開いてなければなりません。、 TCP ポートの 27225
下に見られるテキストチャットボックスを開くには、メインスクリーンから

「 」ボタンを選択してください、TextChat

そこから、テキストを「ユーザーリスト」から選択した「コールサイン」あるいは

「 」宛に送ることができます。SWL

この画像のヘルプを得るには 「短いテキストメッセージ」が表示されるまで、そ、

の上でマウスを動かしてください。

そして、テキストボックスのより多くの情報のある「他のヘルプページ」を得る

には、マウスボタンをクリックしてください。

＊ 「サイドサドル」と「テキストエフェクト」
・ と「 」SideSaddle ＴＥ

「 ＝ 」は 「 」で良好に働きます。TE Text Effects SideSaddle、

これは、画像に通常のテキストと同じように「 テキスト」を書き込むことができ3D

ます。

これには 「 の方法」を学習することがすべてです。、 コピー・アンド・ペースト
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（ ：これは、他のプログラム「 ・ 」などにも訳注 SSTVPalMultiMode MMSSTV」「

適応できるということです ）。

・まず 「 」で画像を選択します。、 Text Effects

画像のあるディレクトリを探します。

その中の一つを選んで、メインウインドウに送ります。

プログラムで、 の画像に拡大されたものであれば、640 x 480

フルサイズに拡大して見るべきです。

・次に 「 ：テキストブラッシ」を開きます。、 Textbrush

「 」を選んで、クリックして開きます。Proper ties

ウインドウの上右部で、希望する「フォント ・ カラー ・ サイズ」を選択でき」「 」「

ます。

＊マウスでクリックすると「色設定画面」が開きます。

＊左マウスを押さえたまま、コンピューター画面上の色にドラッグするとその色を

取り込みます。

「 」で、画像に適した正しい大きさのフォントを得るために、SideSaddle

最良で、好みのサイズを試してみてください。

例えば、画像のサイズが ではフォントは ， では 、320x240 22 800x600 36

では ，など。1024 768 36ｘ
・ 」の画面に戻って 「 」への書き込みの処理をします。「 、Proper ties 画像

・画像にテキストの書き込みを終えるには 「 」ボタンを押してクリップし、、 Copy

「 」 、「 」 「 」 。SideSaddle Pasteプログラムに戻って ボタンを押して に貼り付けますTX

・仕事が終了します。

＊「テキストエフェクト」をダウンロードするには、ここをクリックします。

Copyr ight c 1997-2004 Blaiz Enterpr ises All Rights Reserved.

Company name and all products are intellectual proper ty,

copyr ights and trademarks of Blaiz Enterpr ises

：オンラインフォーラム・SideSaddle Onlain forum

・ ：オンラインヘルプXP Freewall Online Help

（以上 ）



- 12 -

（参考資料）

＊ について。「 」Text Effects
・ は完全に機能するプログラムです。Text Effects

・ とか はありません。インストール セットアップ

・ は、既存のコンピューターファイルとかライブラリーを更新したり、Text Effects

変更することはありません。

・ は、この重大な機能にプライドを持っています。Blaiz Enterpr ises

、 、 、・特別な の 画像挨拶状ロゴ のための素晴らしい マルチカラー 陰影Web / / 3D

回転文字、が作れます。

・ ：特徴

・テキストの陰影（奥行き・アングル・多色）

・テキストの回転 度90, 180, 270

・テキストの横書き 縦書き転回 鏡効果反転。/ / / /

・パラレル処理ダイアログボックス。

・リアルタイムでの画面の色彩の取り込み－クリックとドラグ。

・リアルタイムでの素速い サイズ フォント 表示。/

・超大のフォントサイズ選択。

・画像の フィット レサイズ してのペースト/

・背景色の定義が可能。

・画像を ％ごとに拡大・縮小。25

・レサイズ反転ミラー逆転 転回 左右に ， ， 度。/ / / / 90 180 270

・陰影 ライト影 薄暗いゆがみ。/ /

BMP JPG JPG ICO・多数の画像フォーマット（ ・最適の 、 、

－ツルーカラー 濃いと透明、 ）PPM,PGM,PBM,XBM,TEP,OMI

・ 例の「 ：テキストブラシ」の作動。42 Text Brushs

・オープン画像と「テキストブラシ」のコマンドラインパラメータ

・プリント － 画像プリンターが必要。

・ 」と「 」の補足ツール。「Animated Ar tCard Creations Snappy PhotoCard Creator

・手ごろである。

・完全なヘルプ。

・他国語のインターフェイス。

サポートされた言語の選択のための「選択言語」を参照のこと。

「 」は、あなたの「スタート」ボタンから開始されます・・・。TextBrushs

Star t > Programs > > TextBrushsBlaiz Enterpr ises

「 」は、あなたの「スタート」ボタンで開かれます。Text Effects

Star t > Programs > > Image ToolsBlaiz Enterpr ises

PC Magazine February 2002 Edition (Italy) and accompanying CD ROM of・出版：

" 150 indispensable programs"

Creating Web Pages For Dummies, 6th Edition, March 2002 and accompanying
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＊ ： （プログラム）Text Effects 「 」テキスト・エフェクト
「 」は、 から探して、TE http://www.blaiz.net/ Blaiz Enterpr ises

直接には、 でダウンロードできます。http://www.blaizgraphics.net/TE.ZIP

・ と「 」SideSaddle ＴＥ

「 ＝ 」は 「 」で良好に働きます。TE Text Effects SideSaddle、

これは、画像に通常のテキストと同じように「 テキスト」を書き込むことができ3D

ます。

これには 「 の方法」を学習することがすべてです。、 コピー・アンド・ペースト

（ ：これは、他のプログラム「 ・ 」などにも訳注 SSTVPalMultiMode MMSSTV」「

適応できるということです ）。

・まず 「 」で画像を選択します。、 Text Effects

画像のあるディレクトリを探します。

その中の一つを選んで、メインウインドウに送ります。

プログラムで、 の画像に拡大されたものであれば、フルサイズに拡大640 x 480

して見るべきです。

・次に 「 ：テキストブラッシ」を開きます。、 Textbrush

「 」を選んで、クリックして開きます。Proper ties
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ウインドウの上右部で、希望する「フォント ・ カラー ・ サイズ」を選択できます。」「 」「

（ 」画面に、すぐに反映します）「Sample

・ （フォント） ・ （サイズ）Font Size

▼ボタンで開いて選択します。

・チエックボックスにチエック

マークを付けて選択します。

（ ） （ ）・ 太字 ・ 横書Bold Hor izontal

） （ ）・ 斜体 ・ 鏡反映Italc Mir ror（

・ （ｱﾝﾀﾞｰﾗｲﾝ）Under line

・ （上下反転）Flip

・ （貫通線）Str ikeout

・ （色の反転）Inver t

・ （影の幅） ・ （アングル：角度） ・ （回転角）Depth Angle Rotate

・ （前面色） ・ （背景色）Color R

＊マウスでクリックすると「色設定画面」が開きます。

＊左マウスを押さえたまま、コンピューター画面上の色にドラッグするとその色を

取り込みます。

「 」で、画像に適した正しい大きさのフォントを得るために、SideSaddle

最良で、好みのサイズを試してみてください。

例えば、画像のサイズが ではフォントは ， では 、320x240 22 800x600 36

では ，など。1024 768 36ｘ

・ 」から「 」を選択して、開きます。「TextBrush Open

・画像に書き込む「書体」の選択をします。

・ファイルを選択して好みの「書体」を選びます。

（右のサンプル画面に表示されます ）。

・ 開く」で決定します。「
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＊

「 」の画面に戻って 「 」への書き込みの処理をします。Proper ties 、 画像

・画像にテキストの書き込みを終えるには 「 」ボタンを押してクリップし、、 Copy

「 」 、「 」 「 」 。SideSaddle Pasteプログラムに戻って ボタンを押して に貼り付けますTX

・仕事が終了します。

＊「 」メニュー・コマンド

。取り込んだ画像の加工処理は、メニューコマンドからもできます

（コマンドやショートカットなどの作動は、他の「画像プログラム」と同じです）

・ ：ファイル」「File

・ ：新しく ｘ にレサイズ。New 450x350 450 350

（このサイズがデフォルトです）

・ ： 開いて「幅と高さ」を選択する。New

・ ：New Instance

・ ：画像のホルダーを開く。Open

・ ：ライブラリーから開く。Open from Library

・ ：保存する。Save

・ ：名前を付けて保存するSave As

・ ：ライブラリーへ保存する。Save to Library

・ ：印刷する。Pr int

・ ：終了する。Exit

・ 」で開いた画面で、画像をレサイズします。「New
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・ ：編集」「Edit

・ ：取り消し。Undo

・ ：切り取る。Cut

・ ：コピーする。Copy

・ ：貼り付ける。Paste

・ ：画面にフィットするように貼り付ける。Paste to Fit

・ ：クリアーする。Clear

・ ：背景色の設定。Back ground Color

・ ：画面を常時前面に表示する。On Top

・ ：画像」「Image

・ ： ％の拡大をする。Enlarge by 25% 25

・ ： ％の縮小をする。Shr ink by 25% 25

（クリックするごとに継続して作動します）

・ ：鏡（ミラー）効果、左右反射。Mirror

・ ：宙返り、上下で反転。Flip

・ ：右方向へ回転（ ， ， 度 。Rotate Right 90 180 270 ）

・ ：左方向へ回転（ ， ， 度 。Rotate Left 90 180 270 ）

・ ：色彩反転。Inver t

・ ：明るい陰影。Shade Light

・ ：暗い陰影。Shade Dark

・ ：歪み。Distore

・ ：レサイズ。Resize

・ ：テキストブラシ」「Text Brush

・ ：フォントの選択画面を開く（既述 。Proper ties ）

・ ：画像へのテキスト貼り付け状態を設定。Free Flowing

（ 。 、チエックをはずします テキストをマウスで押さえて

好みの位置へ移動できます）

・ ：デフォルトDefault

・ ：コピー （クリップボードへ）Copy

・ ：ペースト（クリップボードから）Paste

・ ： 」選択画面を開く（既述 。Open TextBrash「 ）

・ ： から開く。Open from Library Library

・ ：名前を付けて保存する。Save as

・ ： へ保存する。Save to Library Library
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・ ：ヘルプ」「Help

・ ： 」のホームページにリンク。Text Effect Homepage TE「

・ ：フリーソフト へのリンク。Free Software Homepage HP

・ ： へのリンク。Visit Blaiz Enterpr iseBlaiz Enterpr ise

＊「 」の要点。ＨＥＬＰ

・ 」「File New－＞

キャンバス（画面）の幅と高さを（デフォルトの「幅 ｘ高さ ピクセル ）450 350 」

指定された「新しい広さのウインドウ」で表示します。

「 ：定義された」ドロップダウンリストで、Predefined

素速い「サイズ選択」ができます。

・ ：背景」のためのいくつかの異なる選択があります：「background

セーブされている背景画像を「 」で開きます。1. File - Open＞

画像を選んで「 」をクリックします。あるいは、Open

「ブロック背景色（画像ではない 」を「 」を選びます。2. ） Edit - Background Color＞

（カラーダイアログが表示されます ）。

、「 」 。 「 」 。色を選択して をクリックします 画面は選んだ 背景色 で満たされますOK

のクリップボード経由で「背景の画像ブロックカラー」を貼り付けます。3. Windows /

例えば 「 （ ＞ 」「 ＞ 」から、 」「Paint Edit - Select All , Edit - Copy

「 」の「 ＞ 」へText Effect Edit - Paste

＊「 」か を選択します。TextBrush - Proper ties＞

「 」ダイアログウインドウが表示されます。TextBrush

・望むように「 」を定義します。TextBrush proper ties

「 」をクリックします。OK

・テキストボックス（ツールバーの右端）に望むテキストを記入して 「 」を、 Apply

クリックします。

・テキストを貼り付けるために、画面をクリックしてドラッグします。

テキストを埋め込むには、マウスを放します。

・テキストをクリアーするには 「 ＞ 」を使います。、 Edit - Undo

＊テキストでペイント（書き込む）するには 「 （動かせ、 TextBrush - Free Flowing＞

る 」を選びます。）

「 」ダイアログウインドウ：TextBrush：テキストブラシ

「 」ウインドウは、並行処理ができます。TextBrush

多くのオプションを選択したり、切り換える時に 「即時に・素速く」行い、、

リアルタイムの選択ができます。

＊ ：フォントFont

「フォント」リストのドロップダウンをクリックして、素速くスクロールするために
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キーボードの「アップ・ダウン」キーを使って 「サンプルウインドウ」で、

異なるフォントをリアルタイムで瞬時に展示させます。

＊ ：サイズSize

ドロップダウン「サイズ」リストをクリックして、素速くスクロールするために

キーボードの「アップ・ダウン」キーを使って 「サンプルウインドウ」で、

異なるテキストサイズをリアルタイムで瞬時に展示させます。

「サイズ」ボックスに直接記入することで、個別のテキストサイズを選択することも

できます。

＊ ：広がり ・ ：角度 ・ ：回転Depth Angle Rotate

「サンプル」ウインドウに「リアルタイム表示」されるそれぞれのドロップダウン

リストから、異なる設定をクリックします。

＊ ：カラーColor

「 」 、 「 」 、左の カラーパレット ボックスは前景の色で 右の カラーパレット ボックスは

テキストの背景色です。

「フルカラーのパレットウインドウ」を取り出すために、どちらかの「パレット」ボ

ックスをクリックします。

両方のパレットボックスは、現在の「画面の色」を取り込むための「クリックアンド

ドラッグ」を持っています。

「 」をクリックすると、前景と背景の色を交換します。Swaps

＊ ：十文字照準線。Crosshair

十文字カーソルは、下部の右側パネルでリアルタイムに表示される交差点がテキスト

の真ん中の位置を示します。

書き込む位置まで十字照準線をクリックしてドラッグします。

テキストを埋め込むにはマウスを放します。

＊ ：固定するための貼り付けPaste to Fit

のクリップボードに（例えば 「 ＞ 「 ＞ 」でWindows Edit - Select All Edit - Copy、 」、

）望む背景画像をコピーします。Paint

から ＞ か をクリックします。「 」 「 」 、Text Effect Edit - Paste to Fit

クリップボードの画像は、現在の「 」の画面寸法で貼り付けされます。Text Effects

「 」 、 、背景画像をレサイズするため し レサイズバーで画面寸法を変更しEdit ->Copy

「 」します。Edit ->Paste to Fit

＊ ：レサイズバーResize Bars

画面寸法を 拡大 縮小 するには、レサイズバー（大きさ、/

幅をつかみ安いこと）を使います。

リアルタイムの「サイズ読みとり」ボタン、内側パネル、

調整中、

、「 」 。注意：正確なピクセルサイズ規格のためには で手動調整しますImage ->Resize
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＊ ： ：テキストブラシ」の説明。TextBrushs Explained 「TextBrushs

「 」は、既存のフォントを強調します。TextBrushs

「 」 、 「 」４２のサンプル テキストブラシ には すぐに製作開始するための Text Effects

が含まれています。

「 」を最初に起動するとき 「 」は「 」ボタンから始めまTextEffects TextBrashs Star t、

す。

Star t > Programs > Blaiz Enterpr ises > TextBrushs

（メモ： 」がスタートボタンから削除されたら、それらは置き換えられま「TextBrushs

せん 。。）

・素晴らしい、衝撃的で、輝いている、新しいフォント効果を作ってください。

Free Flowing TextBrush >素晴らしいペイント効果のために 「 ：自由描画」選択 「、 、

」を使って 「 」で 描画ペイントしてください。Free Flowing = ticked TextBrushs /、

＊ ：特徴。Features

・ カラー陰影。3D

・ ， ， 度の回転。90 180 270

・ （とんぼ返り 鏡効果 。Flip/Mir ror / ）

・縦書き 横書き/

・あなた自身の「 」の製作。TextBrashs

「 」を選択します。TextBrush -> Proper ties

「 」ダイアログウインドウが開きます。TextBrush

「望む 」を定義して 「ＯＫ」をクリックします。TextBrush 、

・ 」を開きます。「TextBrush

「Start」ボタンから開いて 「 」で「 」を選びます。、 Blaiz Enterpr ises TextBrush

「 」ウインドウが表示されます。Open

「 」を選んで「 」をクリックします。TextBrush Open

「 」を （保存）します。TextBrush Save

・ 」を選択します。「TextBrush > Save to Star t Button...－

「 」ウインドウが表示されます。Save As

名前をタイプして 「 ：保存」をクリックします。、 Save

・ 画像を保存」します。「

「 」を選びます。File -> Save As

「 ：名前を付けて保存」ダイアログが開きます。Save As

名前を選んでタイプして、適切な画像フォーマットを選択します：

・ ：ビットマップBitmap

・ ：ジェーペグJpeg

・ ：透明アイコンTransparent Icon

・ ：アイコンIcon

（アイコン透明度は、上部の左ピクセルで計算されます ）。

アイコンは、幅 ｘ高 ピクセルに固定されます。32 32

・ ：ポータブルピクセルマップ（バイナリー）Por table Pixelmap
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・ ：ポータブルグレイマップ（ バイナリー グレーの陰影）Por table Graymap /256

・ ：ポータブルビットマップ（ バイナリー モノクローム）Por table Bitmap /

・ ：Ｘビットマップ （モノクローム）X Bitmap

Text Picture 64 )・ ：テキストピクチュアー （モノクロ・ 色

「 ：保存」をクリックします。Save

ノート： 」は、 画像に使うフォーマットです。「Jpeg Web

＊ ：プリントPr int

」を選ぶか、もし現れていたら「画像プリンター」を表示するFile > Pr int

をクリックします。

＊ ：背景チップBackground Tip

クリップボードからの背景画像のペーストは、ファイルを開くことでのWindows

利点を持たせることができます。

テキストの埋め込みを望まない背景画像の更新が必要なときの、

「改新」を始める「 ＞ 」が、素速く、容易にできます。Edit - Paste

＊ ：コマンドラインパラメータ。Command Line Parameter s

C:\ TE.EXE <Image filename> <TextBrush filename>

C:\ TE.EXE C:\ 1.BMP C:\ 1.TBH例えば：。

「 」 、 「 」 、「 」 「 」 。Text Effects 1.BMP Text Brush 1.TBHは 画像 を開き を に設定する

＊ と の補足ツール。Animated Ar tCard Creations Package Snappy PhotoCard Creator

・ ：Animated Ar tCard Creations Package

「ブロックカラーカンバス」の「 」にテキストを作ったあと、Text Effects

（すなわち、背景のように使われた画像がない 「 ＞ 」を選択します。） Edit - Copy

「 」からの画像テキストは、 のクリップボードにコピーされます。TextEffects Windows

Animated ArtCard Creations Animation > Paste from Still「 」のメインメニューから「

」を選択します。Image

「 」 、「 」 。Text Effects Ar tCardの画像テキストは トランスペアーレント に表示されます

置くべき位置、定義されていないテキスト、あるいはスクロールして見えるテキスト

アニメーション 画像をドラッグします。/ /

・ ：Snappy PhotoCard Creator

「 」 、「 」 。背景画像に で テキストを作ったあと を選択しますText Effects Edit ->Copy

「 」のメインメニュー「 」から、Snappy PhotoCard Creator Picture- > Paste

「 」の背景が、３Ｄテキストでクリップボードの画像を表示します。Photo Card

＊ ：ライセンス協約License Agreement

我々の サイト上の、会社名とすべてのソフトウェアプロダクトは、Web

が知的財産、著作権、登録商標を所有しています。Blaiz Enterpr ises

すべてのタイトル、著作権、知的財産権、ソフトウェアプロダクトと内容、それらに

関するすべてのコピーでも、 が所有権を持ちます。Blaiz Enterpr ises

・ ： 許可License

は、あなたがソフトウエアープロダクトを使う権利を承認します。Blaiz Enterpr ises

あなたは、ソフトウエアープロダクトの技術を改変したり、デコンパイルや逆アセン
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ブルしてはなりません。

オリジナルソフトウエアーを変更するいかなる変更や試みは、致命的なエラーを起こ

したり、プロダクトを不安定にする原因になります。

・ ：損害の保障Indemnity

ソフトウエアープロダクトの使用は、すべてあなた自身のリスクです。

は、表示されると否とに関わらず、すべての保証や条件をBlaiz Enterpr ises

否認します。

は、ソフトウエアプロダクトの使用に当たって、使用不可能のためBlaiz Enterpr ises

に起きた 特別な、付帯的な、間接的であれ、重大な損害（無制限な、商用での損失

の損害、利益、商用妨害、商用情報の損失、あるいはすべての金銭的な損失を含む）

に対する責任を持つものではありません。

（ ）参考資料
＊「 ： 」Setting up your Webcam Web カメラの設定
「 」で「 」 を動かすようにするのを待っているみなさんのためにSideSaddle WebCam

は、言わばすでに組み込み済みといえます。

・まず、下の から ダウンロードできる「 」のような プログラムURL WebCampryme

が必要です。

http://www.hilo.dk/programming.asp?topic=pryme

・ 」は、 で、大変うまく作動します。「Pryme SideSaddle

しかし、それをインストールしたら 「コンフィギュアー：構成」しなければなりま、

せん。

「 」を起動したら 「セットアップメニュー」をクリックして 「セットアップpryme 、 、

メニュー」の選択せねばなりません。

・下のサンプルに見られるように「プログラム」の設定をすべきです。

「 ：キャプチュアー時間」を「５秒」ごとにセットします。Timed captur ing every

若干の「より遅いコンピューター」では、これをわずかに長くする必要があるでし

ょう。
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あなたの持っている「ビデオデバイス（装置 」は、上記のものと違うかもしれま）

せん。

それに適したものに設定してください；

あなたのカメラでは、メインセットアップメニューで「ビデオデバイス」のいくつ

かの設定の必要があるかもしれません。

「 」カメラとしてどのようなデバイスを使うとしても、おそらく異なるでWebCam

しょう。

・あなたのページが、これのように見えることを確認してください。

デフォルトインストール以外のディレクトリにインストールして・ 」を、「SideSaddle

は 「画像フォルダー」が上と同じであるかを確認してください。いないとき 、
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もし、 は 「 」の「 」デイレクトリへの他のホルダーであるとき 、 SideSaddle AutoSend

ください。「パス」ポイントを確認して

このページは します。「 」デフォルトに設定pryme

そして 。、「 」を使わないのであれば、変更すべきではありませんmotion detection.

このページでは、日時のスタンプを「 」画像に書き込む時に、WebCam

お好みに従って設定を変更できます。

・上に見られるように、ページを設定してください。

」がチエックされていることを確認してください。・「View Preview

・ 」を「 」にセットしてください。「pryme auto captur ing mode
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・ 」の名前を「ｘｘ 」に変えてください。「2.JPG 2.jpg

「 」 、「 」 「 」すでに に戻る準備ができていれば に戻って リネームauto send mode 2.jpg

してください。

「 」 「 」 。・ の ボックスがチエックされているかを確認してくださいsidesaddle auto reply

誰かが画像をあなたに送ったときに、あなたの「 」から最新の画像が送られWebcam

ます。

・ 」「Pryme

メモ：私は現在 「 」を働かせていません。、 Pryme

プログラムに対するどのようなサポートも提供しません。

、 、 （ ）しかしながら もしあなたが興味を持っているなら 最後のバージョン １２６.

はまだダウンロードが利用可能です。

古い「 」ページは、 です。Pryme Web www.hilo.dk/pryme

「 」 は、 から写真をグラブして、 を使っているホームページPryme WebCam FTP

に、それらをアップロードすることができます。

特徴：

へのアップロード。FTP

：動作検出Motion Detection

：画像のキャプションCaption for images

： ページの画像履歴Image history on webpage Web

Pryme.exe (Version 1.26, 1.103 Kb)

（以 上）


